New Features and
Enhanced Functionality
In GeneSpring GX 11

Agilent Technologies




Enhanced Visualization



Flexible and Interactive Genome Browser

 From Menu, Views > Genome Browser

« Multiple experiments can be displayed in
the same Genome Browser

— Drag-and-drop experiment into Genome
Browser



Track Plot Options in Genome Browser

Annotation Track

Histogram

Scatter Plot

Profile Plot

Region Plot




GeneSpring GX 11 Genome Browser Navigation

e Jump to Chr of interest:
— Chr Selector Pane
— Drop-down menu in window

e Zoom into region of interest:

— Click drag box in Cytoband view
in Summary Panel

— Shift drag box in any data or
annotation track

« Pan around region of interest:

— Click on any track and drag
right-left with mouse

— Scroll up-down on mouse wheel

— Use right-left arrows within any
track



GeneSpring GX 11 Genome Browser Navigation

 Entity Lists can be displayed
in Genome Browser and used
for navigation of tracks:

— Scroll via right-left arrows of

Entity List track instructs
GeneSpring GX to navigate
by jumping to next entity of

interest in list



Plot Entity Lists in Genome Browser

« By default, entities in list are plotted as regions by their genomic
coordinates



Spreadsheet Tab in Genome Browser

Search for Entity in Spreadsheet

Spreadsheet shows
data for selected Track

Spreadsheet tab
displays data for
selected track

Search for Entity of
interest using value of
any Spreadsheet
column

Entity is highlighted in Track
view



GeneSpring GX 11 Genome Browser

Copy Number Track

Log Ratio Track

Merge tracks
1and 2

T4

Multiple samples or
conditions can be displayed
as individual tracks or
merged into the same track

Data from different
experiment types (i.e. copy
number, gene expression,
genotyplng) can be
displayed in same browser
and merged

Plot intensity values, copy
number, LOD, allele
frequency, Entity Lists and
other values

Annotation tracks can be
imported and displayed (i.e.
MiRNA, CpG islands,
transcript)



Densrty VleW |n Genome Browser 3. Entities in selected track is

displayed in Chromosome
Selector panel
<« 2. Click on “Show density in
Chromosome Selector” icon

\

1. Select track to view
density across all
chromosomes

« Allows you to view all entities in selected track for all chromosomes

« Example: Entity List obtained from Common Genomic Variant Regions Analysis
shows regions of common variation in Chromosome Selector panel



Import and Manage Tracks in Genome Browser

Click on Organism folder to 1) Delete

or add new organism and 2) Add New
/ build for chosen organism

Click on Build folder to 1) Delete or add
new build and 2) Delete or add track
features



Import Tracks for Viewing in Genome Browser

-_

-

BED format is automatically
recognized in GeneSpring. Other
formats can be imported through
“Advance Import “

Define columns to import for

custom track files



Find Entity In View

e

e



Improvements to PCA Plot

Mouse over to see
sample annotations

/

PCA Scores added
to axes

o

Distinguish two
T parameters with
shape and color




Display Multiple Histograms in One View

Compare distributions of
Intensity values across multiple
samples or conditions

Plot Raw or Normalized values
to assess effect of
normalization

Selected Entities (yellow) are
displayed across all histograms

To access, Menu > View >
Histogram > Multiple or select
Histogram icon in toolbar



Order Probes by their Annotations

x

ol

*Probes in Condition Tree can be
ordered according to annotation
values




Tabbed Visualization Windows

Tabbed windows allow easy switching between different visualizations
and plots to facilitate interrogation and comparison of data



More Options for Plotting Data

)

Choose to plot raw or normalize
values in log10 or linear scale on a
Scatter or Profile Plot

To access, Menu > View >
LoglO/Linear Values



Data Import,
Normalization, and
Transformation



Support for Affymetrix Text and Pivot Files

« Affymetrix text and pivot files can be now be imported into standard Affymetrix technologies
that support .CEL and .CHP files

— No longer need to create Generic Data for Affymetrix text and pivot files, as data file format
Is automatically recognized



Import GEO Dataset and Create Experiment In
GeneSpring GX

-)

From menu > Tools > Import NCBI GEO Experiment

* Experiment title and note imported into Experiment notes section

o Sample classification imported as Parameter values in Experiment
Grouping window



Normalize to External Value

N

Scale data to a user-defined value

-

Different samples can be scaled to different value



Use Median or Mean Intensity Values for Baseline
Transformation

Choose “median” or

>

AN

Window can now
be re-sized to
display long sample
names




“Save as default” Option for Agilent Flags

* By default, all spot problems
marked as “Absent” for Agilent
microarrays

» User can change this and save this
change as default by checking
“Save as default” box

» Future creation of Agilent
experiments will reflect this saved
change



View How GeneSpring Is Using Information in Data
File

Go to Filter on Data File and see how GeneSpring is using each
column in data file

eldentifier
*Raw Signal

*Flag



Global Entity Lists

» Global Entity Lists are Entity Lists

that will be always be available in
Navigator regardless of what
Project is opened

To mark as Global List, right-click >
Mark as Global List

— Entity List will appear in Global Lists
folder

To unmark Global List, right-click on
Entity List in either Experiment
Navigator or Global Lists folder >
Unmark as Global List

— Entity List will be removed from
Global Lists folder



New Features and
Enhanced
Functionalities



Build Networks Using MeSH Terms

—

» Relations in Pathway Interaction databases are associated with MeSH terms
* Using MeSH term as input, retrieve relations in interaction database and build network using these relations

» This allows you to generate a network that represents molecular interactions associated with the medical
concept



Easier way of selecting multiple Entity Lists for
Venn Diagram

Drag-and-Drop
Entity Lists

Select Entity Lists
from window

Entity List Selection window for Venn Diagram automatically opens to display all Entity Lists for all
open experiments

Multiple Entity Lists can be selected from window at once (Ctrl click) to display in Venn Diagram

Entity Lists can also be dragged and dropped into Venn Diagram



Combine Entity List Associated Values from
Multiple Entity Lists Using Venn Diagram

I



Gene-level and Probe-level Expression Analysis

Probe-level
experiment | —

Gene-level | 7
experiment

Expression data can be analyzed at gene-level or probe-level

« Signal intensity values summarized using Entrez ID



Filter on Entity List- Associated Values

- -
-

Take an Entity List
and filter Entities on
any Associated
Values or
Annotation columns




Filter on Entity List- Annotations




Find Similar Entity List Works Across User-
selected Target Entity Lists and Target Types

Allows you to quickly compare results between experiments

Determine if there is a significant overlap between any two Entity Lists:

*  Within same Experiment
e Across Experiments within same project
e Across Experiments in entire database of GeneSpring GX



Modification to TargetScan Gene Target
|dentification

» For non-Agilent miRNA, user needs to use column containing microRNA
names (e.g. mmu-miR-1) as identifier in GeneSpring GX 10

* In GeneSpring GX 11, user does not have this limitation, as you can now
specify which column to query TargetScan Database (red box above)



Fold Change Automatically Calculated During
Statistical Analysis

» Choose specific pairs of
conditions or choose all
conditions against a
specific condition to
calculate FC

e FC calculation can be
skipped




Support for Agilent .gpr Data

Agilent data output from Axon
Scanner as .gpr file now
Imports into standard Agilent
technology

« AMADID is read and proper
technology is downloaded if not
already present

» Leverage probe annotations from
Agilent



Entity Inspector Additions

 Box Whisker Plot added to Entity Inspector

 Ability to show Standard Error or Standard Deviation bars in Entity
Inspector (Right Click in Profile Plot > choose Standard Error, Standard
Deviation, or None)



Partial Least Squares Discriminant

« Partial Least Square
Discriminate has been added
as an option for Class
Prediction analysis

— Other class prediction algorithms
include Support Vector Machine,
Decision Tree, Naive Bayes, and
Neural Network



Configure ldentifiers to Use for Translation
Mapping

» By default, translation of
probes between
experiments (of same or
different technologies) is
done by Entrez ID

 |dentifiers used for this
translation mapping can
now be changed to values
In any technology
annotation columns



Genomic Copy Number
Analysis



Copy Number Variation- Understanding the
Relevance to Human Diseases

» Copy number variation (CNV):

— DNA segments in which copy-number varies
between two or more genomes

— Ranges from 1 Kb to millions of DNA bases
In size

 CNVs have been associated with susceptibility
to disease, complex behavioral traits, and other
phenotypic variability

 |dentifying significant CNVs is important in
understanding the underlying mechanism of
disease and disease susceptibility



Copy Number Analysis in GeneSpring GX 11

Support for Affymetrix and lllumina whole-genome genotyping and CNV
analysis microarrays

Support for paired-normal and reference (standard HapMap or Custom)
designs

Algorithms Used in GeneSprings.

o Affymetrix:
— Birdseed or BRLMM for generation genotype calls

— Circular Binary Segmentation for identification of genomic segments of equal
copy number

— HMM for calculation of LOH scores
— Fawkes for computation of allele-specific copy number
 [llumina:
— Import genotype calls, copy number and LOH scores from lllumina BeadStudio



Copy Number Analysis Workflow in GeneSpring

Batch Correction

-

GX 11

Segmentation, Copy Number,
and LOH calculation

-

GISTIC for Identification of
Statistically Significant CN variation
within a set of samples

-

Filter for Regions of
Interest
E =

Biological Contextualization of

Genes in Regions of interest




Find Common Aberrations




Support for Copy Number and LOH Analysis
Workflow

 Filter regions by:
— Min number of probes in region
— Genomic copy number
— Copy number confidence score
— LOH score
— Log ratio values

« |dentify regions of LOH with copy
number = 2

 |dentify parent-specific copy number
variant regions

* |dentify regions that overlap with
regions in Database of Genomic Variant



Biological Contextualization of Copy Number Data

=
vy,

NetWo rk
Ana/ Sis




Genome-wide
Association Analysis



Genome-wide Association Study

 Single nucleotide polymorphisms (SNPs):

— DNA sequence variations that occur when a
single nucleotide in genome is altered

— Variation must occur in at least 1% of the
population to be considered a SNP

— Occur every 100 to 300 bases

« |dentification of SNPs with significant association to
disease can point to regions of human genome
where disease-causing genes may reside



Support for Genome-wide Association Studies

e Support for case-control studies
« Support for Affymetrix and lllumina whole-human genotyping arrays

» Genotype calling algorithms
— BRLMM and Birdseed for Affymetrix
— Genotype calls imported from GenomeStudio for lllumina



Quality Control of SNP Data

e Quality Control

— Sample outlier detection using
EIGENSTRAT

— Metrics from Birdseed

— Filter SNPs on: Missing genotype call,
violation of Hardy-Weinberg Equilibrium,

and minor allele frequency



EIGENSTRAT Correction

 Use EIGENSTRAT to detect sample outliers

« Select significant Principal Component and outlying samples
with 5 std dev



Test for Association

» Cochran-Armitage, Chi-square, Fisher’s
Exact and Correlation Trend for testing
Individual SNPs

— Genomic Control or EIGENSTRATE
can be applied to correct for
population stratification

— Specify models of inheritance:
Additive, Dominant, Recessive,
Custom



Haplotype Trend Regression

 EM algorithm used to infer
haplotypes

» Test for association to
gualitative or guantitative

e Only first SNP of block
listed in Probe Set ID
column



Linkage Disequilibrium Plot

Visualize LD as R? or D’

Select SNPs with high LD in view and save as Entity List



GeneSpring GX
Resources



Web Resources at www.genespring.com

Tutorials
« Data analysis tutorials for Affymetrix gene expression, Agilent gene expression, Exon Splicing,
Genomic Copy Number,

e http://www.chem.agilent.com/en-
US/Products/software/lifesciencesinformatics/genespringgx/pages/gp34528.aspx

Viewlets
« Short animated tutorials on various topics such as Quality Control on samples, Updating
Pathway Interactions, miRNA Analysis Using TargetScan and more

e http://www.chem.agilent.com/en-
us/products/software/lifesciencesinformatics/pages/gp34743.aspx

Recorded and Live eSeminars

» Sign up for live eSeminars on various topics such as Introduction to GeneSpring GX 11, Joint
Analysis of Gene Expression and Genomic Copy Number data, and more

* View recorded past eSeminars

» http://www.chem.agilent.com/en-US/Events/en-US/Pages/326B.aspx




Web Resources at www.genespring.com

GeneSpring GX Workshops

» Register for Levels I, Il, and Ill GeneSpring GX training workshops

e http://Iwww.chem.agilent.com/en-
us/products/software/lifesciencesinformatics/pages/gp34709.aspx




